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MAKER-UNO
Maker UNO, an Arduino UNO compatible board designed and developed specially for 
students to learn coding and microcontroller. We named it Maker UNO to encourage 
everyone to be a maker by getting started with this amazing board..

MAKER - UNO Features:
- SMD ATmega328P microcontroller(the same microcontroller on Arduino UNO) with    
  Optiboot (UNO) Bootloader.
- USB Programming facilitated by the CH340.
- Input voltage: USB 5V, from computer, power bank or standard USB adapter.
- 500mA (maximum) 3.3V voltage regulator.
- 0-5V outputs with 3.3V compatible inputs.
- 14 Digital I/O Pins (6 PWM outputs).
- 6 Analog Inputs.
- ISP 6-pin Header.
- 32k Flash Memory.
- 16MHz Clock Speed.
- R3 Shield Compatible.
- LED array for 5V, 3.3V, TX, RX and all digital pins.
- On board programmable push button (pin 2, need to con�gure as INPUT_PULLUP).
- On board piezo buzzer (pin 8).
- Utilize USB Micro-B socket.
- PURPLE PCB!
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MAKER-UNO BOARD

Micro USB B Type Connector (Female) 
Main supply for Maker Uno. Used for program 
and debug purpose (Serial Monitor) too.

Reset Button 
Button to restart Maker UNO program.
Programmable Button 
This button is connected to pin 2 and GND. To 
use it, user need to con�gure it as 
INPUT_PULLUP.

Series of LED for Digital I/O
Every digital IO is equipped with LED, where 
you can control it or make it as indicator for 
input.

Digital Pin
This pin can be used with :
digitalRead(); as an input
digitalWrite(); as an output

~PWM Pin
The digital pin that has this symbol  can only use 
analogWrite(); to control the output. (0-255) 

Power Pin
GND - Ground Pins

5V - Regulated 5V output
3V3 - Regulated 3.3v supply

Analog Pin
This pin can be used with 
analogRead(); to read an 
input in analog form (0-1023) 

Piezo Buzzer Slide Switch
Slide switch to connect 
between pin 8 to piezo buzzer. 
To use piezo buzzer, slide the 
switch on and program the 
buzzer. To use pin 8 for other 
purpose, slide the switch o�.

Piezo Buzzer
Piezo buzzer is connected to 
pin 8 through slide switch.
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DOWNLOADING ARDUINO IDE
Maker UNO requires Arduino software to run. You can download the software from Arduino 
website (http://arduino.cc/en/Main/Software) and it is free to use.

Arduino IDE is compatible with Windows, Mac OS X and also Linux. You just need to choose 
the appropriate operating system installation package for your computer. 

*Note: If you are a Windows user, it is recommended that you choose Windows (installer).
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Choose the installer that compatible with your laptop OS and download the Arduino IDE. 
You will have arduino-1.8.x-windows.exe software after �nish downloading for Windows OS 
user while for Mac OS user, you will get a zip �le of arduino-1.8.x-macosx zip �le as shown 
below : 

*Note: For latest version of Arduino IDE, go to https://www.arduino.cc/en/Main/Software

Double-click on the icon to install Arduino IDE. Complete the download, proceed with the 
installation as usual. After �nish installing the software, you can start using it by double-click 
on the icon. Then, you will see this layout of Arduino IDE. 
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Open Serial Monitor.
Serial

Monitor

This button opens up a new code window tab.
New 

Sketch

This saves the currently active sketch.Save

This button will let you open an existing 
sketch.Open

Sends your code to the Maker UNO.  When you 
click it, you should see the lights on your 
board blink rapidly.

Upload

Compiles and approves your code. It will 
detect errors in syntax (e.g. missing semi colon 
or parentheses).

Verify
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installing MAKER uno driver
Download Maker UNO driver at Maker Uno product page (under Attachment tab). Please 
choose appropriate driver depends on your OS. Complete the download, proceed with the 
installation as usual.

After installation is complete, your Maker UNO port should appears at Device Manager 
under Ports (COM & LPT) - e.g. USB-SERIAL CH340 (COM3). Please remember the port 
number.
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Select Board :

Select Serial Port :
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Maker UNO comes with board package too. You can install it using the URL link below. Copy 
the URL link below and paste it into the Additional Boards Manager URLs (Go to File > 
Preferences). Then click OK.

The link:
https://cytrontechnologies.github.io/package_cytron_makeruno_index.json

installing MAKER uno BOARD PACKAGE
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You need an internet connection during board package installation.

Open Boards Manager (Go to Tools > Board > Boards Manager...), �nd Maker Uno board 
package from Cytron Technologies and install.

Once installed, you should be able to select Maker UNO as your Board (Go to Tools > Board), 
and proceed with uploading as usual.

NOTE
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CAUTIONS

What happens if I just select Arduino/Genuino Uno instead of Maker UNO?

Arduino/Genuino Uno by default will set all IO pins to INPUT. If you upload the Blink 
example to Maker UNO, LED 13 will start to blink and also other LEDs light up randomly, 
(i.e. sometimes all LED turns on). This is because the voltage on the pins set to INPUT are 
�oating. If you don’t set those pins to OUTPUT or connect them to an external circuit, it 
will produce a �oating voltage (i.e. 1V, 2V or any voltage in range of 0-5V). This �oating 
voltage is enough to light up the LED occasionally. Actually this is not a problem, just 

confusing for newbies/beginners trying to learn using a Maker UNO.

We create a custom board package for Maker UNO to eliminate this confusion. The 
Maker UNO board package initializes all digital IO pins to OUTPUT by default. Now when 

you upload the Blink example, only pin 13 will blink, other pins will remain o�. We feel 
this approach is better for a newbie/beginner, HOWEVER we advise to use this method 

only for early lessons. Once you understand the reasons to set a pin as INPUT and 
OUTPUT, we advise you to select Arduino/Genuino Uno as a board for safety purposes.



LESSON 1 : 
THE LED (DIGITAL OUTPUT) 
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11

Open new sketch on Arduino IDE.

2

Write this code to your sketch : 

void setup()
{ // put your setup code here, to run once:
  pinMode(7, OUTPUT);
}

void loop()
{ // put your main code here, to run 
repeatedly:
  digitalWrite(7, HIGH);
}

LESSON 1 : 
LIGHT UP THE LED (IDE) 

i
LED is a light emitting diode. It will light up when a proper 
voltage is applied in correct direction.

2
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The void setup() runs once when the Maker UNO 
is powered on. The code in the void setup() usually 
use to con�gure the pin as INPUT or OUTPUT 
using pinMode();

The void loop() runs continuously after the void 
setup() has complete. The code in the void loop() 
usually use to control the INPUT and OUTPUT. 
The digitalWrite(); is used to set the digital 
OUTPUT of the pin number to HIGH or LOW

13

Compile the �le. 

1

4

Upload the sketch.

15

You will see status of  “Done Uploading”if 
everything is correct your LED at pin 7 will light up.

4

43



LESSON 2 : 
LED (BLINKING) 
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LESSON 2 : 
LED BLINKING (IDE) 

11

Open new sketch on Arduino IDE.

2

Write this code to your sketch : 

void setup()
{ 
  pinMode(7, OUTPUT);
}

void loop()
{
  digitalWrite(7, HIGH);
  delay(1000);
  digitalWrite(7, LOW);
  delay(1000);
}

i
LED will blink when delay is applied between ON 
and OFF. Then it will blinking!

2
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1

The digitalWrite(7, HIGH);  digital pin number 7 
is set to HIGH which is to turn ON the LED while 
the digitalWrite(7, LOW);  digital pin number 7 is 
set to  LOW which is to turn OFF the LED.

The delay(); is a function to make the Maker UNO 
execute anything for the time set in miliseconds. 
1000 is equal to 1second.

13

Compile the �le. 

1

4

Upload the sketch.

15

You will see status of  “Done Uploading” if 
everything is correct and your LED will 
blink.

4

43



LESSON 3 : 
FADE AN LED 
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11

Open new sketch on Arduino IDE.

2

Write this code to your sketch : 

int LED = 3;
int brightness = 0;
int fadeAmount = 5;

void setup()
{
 pinMode(3, OUTPUT);
}
void loop()
{
  analogWrite(LED, brightness);
  brightness = brightness + fadeAmount;
  if (brightness <= 0 || brightness >= 255) 
   { 
    fadeAmount = -fadeAmount;
   }
  delay(30);
}

LESSON 3 : 
FADE AN LED(IDE) i

The LED will fade using analogWrite() function using 
Pulse Width Modulation (PWM) which make a digital 
output acting as analog output.

2
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1

The analogWrite() function uses PWM, so if
 you want to change the pin you're using, be
 sure to use another PWM capable pin. On most
 Arduino, the PWM pins are identi�ed with 
 a "~" sign, like ~3, ~5, ~6, ~9, ~10 and ~11.

The analogWrite(LED, brightness);  set OUTPUT 
of the pin number 3  to variable “brightness”. The 
LED will light up based on the amount of variable 
“brightness”.

13

Compile the �le. 

1

4

Upload the sketch.

15

You will see status of  “Done Uploading” if 
everything is correct and your LED will fade.

4

43



LESSON 4 : 
PUSH BUTTON (DIGITAL INPUT)
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11

Open new sketch on Arduino IDE.

2

Write this code to your sketch : 

int LED = 4;
int Button = 2;

void setup()
{
 pinMode(4, OUTPUT);
 pinMode(2, INPUT_PULLUP);
}
     
void loop()
{
  if (digitalRead(Button) == LOW) 
  digitalWrite(LED, HIGH);   

  else if (digitalRead(Button) == HIGH)           
  digitalWrite(LED, LOW);
}

LESSON 4 : 
PUSH BUTTON (IDE) i

Push button act as a digital input device. Maker UNO 
is able to sense 2 states for digital input, i.e. HIGH and 
LOW. Push the button and the LED will turn ON!

2
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1

Using pinMode(INPUT_PULLUP), there is an 
internal 20K-ohm resistor is pulled to 5V. This 
con�guration causes the input to read HIGH when 
the switch is open, and LOW when it is closed.

The if() statement is use to compare  a condition 
whether it is TRUE or FALSE. 
The else if() statement is use to set other 
condition than if() statement. 
The digitalRead(Button) == LOW);  will read the 
button input. If the button is pushed, the INPUT 
will be LOW.

13

Compile the �le. 

1

4

Upload the sketch.

15

You will see status of  “Done Uploading” if 
everything is correct, when button is pressed, the 
LED pin 4 will light up.

4

43



LESSON 5 : 
SERIAL WRITE
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11

Open new sketch on Arduino IDE.

2

Write this code to your sketch : 

void setup()
{
 Serial.begin(9600);
 Serial.print("Hello, World!");
}
void loop()
{
  
}

LESSON 5 : 
SERIAL WRITE (IDE) 

2
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1

The Serial.begin(); open a serial communication 
between the Maker UNO and the computer. 9600 
is the baud rate of the comunication. The serial 
monitor must use the same baud rate to view the 
information.

The Serial.print(); sends information from Maker 
UNO to the connected computer. The information 
will be in the serial monitor.  

The Serial.println(); sends information from 
Maker UNO to the connected computer. The 
information will be in the serial monitor and print 
out line by line.

13

Compile the �le. 

1

4

Upload the sketch.

15

You will see the Button status through the Serial 
Monitor. Press the button to see the result! 

4

43

5

i
 Click on the         symbol to see the result!



LESSON 6 : 
SERIAL READ
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11

Open new sketch on Arduino IDE.

2

Write this code to your sketch : 

int LED = 7;
int data = 0;

void setup()
{
 pinMode(LED,OUTPUT);
 Serial.begin(9600);
}
void loop()
{
  if(Serial.available() > 0 ) 
  {  
     data = Serial.read();
     if(data == '1') 
     {  
      digitalWrite(LED, HIGH); 
     }  
     else if(data == '0')           
     {
      digitalWrite(LED, LOW); 
     }
 }  
}

LESSON 6 : 
SERIAL READ (IDE) 

i
Serial display can display numbers and characters 
(based on ASCII data) on the Arduino Serial Monitor. 
Click on the         symbol to enter the input.

2
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1

The Serial.available() get the number of bytes 
(characters) available for reading from the serial 
port.
The Serial.read() reads all the incoming data in 
Maker UNO.

13

Compile the �le. 

1

4

Upload the sketch.

15

You can turn on the LED pin 7 by inserting the letter 
“1” and turn it o�  using “0” at the Serial Monitor.

4

43

5



LESSON 7 : 
TONE MELODY
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11

Go to File > Examples > 02. Digital > toneMelody

LESSON 7 : 
TONE MELODY (IDE) 

1
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1

12

Compile the �le. 

1

4

Upload the sketch.

14

You can change the music note based on your 
preference and enjoy the music tone.

3

32

i
You can refer to the next tab pitches.h for more music 
note!

i



LESSON 8 : 
POTENTIOMETER AS ANALOG INPUT



LESSON 8 | 38

LESSON 8 : 
SCHEMATIC DIAGRAM 
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11

Open new sketch on Arduino IDE.

2

 Write this code to your sketch : 

int sensorPin = A0;
int ledPin = 13;
int sensorValue = 0;

void setup()
{
  pinMode(ledPin,OUTPUT);
}
     
void loop()
{
  sensorValue = analogRead(sensorPin);
  digitalWrite(ledPin, HIGH);
  delay(sensorValue);
  digitalWrite(ledPin, LOW);
  delay(sensorValue);              
}

LESSON 8 : 
POTENTIOMETER ANALOG INPUT (IDE) 

2
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15

Turn the potentiometer and you will see the blinking 
speed change. 

13

Compile the �le. 

1

4

Upload the sketch.
4

43



LESSON 9 : 
LDR AS ANALOG INPUT
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10KΩ
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RX     0
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2
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4
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~10
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13
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GND

LESSON 9 : 
SCHEMATIC DIAGRAM
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11

Open new sketch on Arduino IDE.

2

 Write this code to your sketch : 

int LDR = A0;
int ledPin = 13;
int LDRvalue = 0;

void setup()
{
  pinMode(ledPin,OUTPUT);
}
     
void loop()
{
  LDRvalue = analogRead(LDR);
  if(LDRvalue > 600)
  digitalWrite(ledPin, HIGH);
  else
  digitalWrite(ledPin, LOW);              
}

2

LESSON 9 : 
LDR ANALOG INPUT (IDE) 
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15

When it is dark, the LED on pin 13 will light up.

13

Compile the �le. 

1

4

Upload the sketch.
4

43



LESSON 10 : 
CONTROLLING MOTOR
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LESSON 10 : 
SCHEMATIC DIAGRAM 
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11

Open new sketch on Arduino IDE.

2

 Write this code to your sketch : 

void setup()
{
  pinMode(6,OUTPUT);
}
     
void loop()
{
  analogWrite(6,255); //same with HIGH
  delay(1000);
  analogWrite(6,123);
  delay(1000); 
  analogWrite(6,50);
  delay(1000);
  analogWrite(6, LOW);//same with 0
  delay(1000);              
}

2

LESSON 10 : 
CONTROLLING MOTOR (IDE) 
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15

The motor will rotate with 4 di�erent speed.

13

Compile the �le. 

1

4

Upload the sketch.
4

43



PROJECT



INTRODUCTION
Interactive Tra�c Light is a combination of standard tra�c light for 
vehicles and tra�c light for pedestrian. 

This project applies knowledge outcome from:
Lesson 1: Light Up LED 
Lesson 4: Push Button as Digital Input

INGREDIENTS
a. Maker UNO - 1x
b. Breadbord - 1x
c. Red LED - 2x
d. Green  LED - 2x
e. Yellow LED - 1x
f.  Resistor 220Ω - 5x
g. Jumper wires

INSTRUCTION
By using all the parts above, create a simple tra�c light system for a pedestrian 
crossing. Normally, the tra�c light is green. But when the push button is pressed, 
the light will switch to yellow for two seconds, then to red. After 1 more second, 
the green pedestrian light will light up for 5 seconds, then turns back to red. 
After 1 more second, the tra�c light turns green again.

PROJECT 1 | 50

PROJECT 1
INTERACTIVE TRAFFIC LIGHT
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SCHEMATIC DIAGRAM

HARDWARE CONNECTION
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const int greenLedVehicle = 5;
const int yellowLedVehicle = 6;
const int redLedVehicle = 7;
const int greenLedPedestrian = 3;
const int redLedPedestrian = 4;
const int pushButton = 2;

  void setup()
{
  pinMode(greenLedVehicle, OUTPUT);
  pinMode(yellowLedVehicle, OUTPUT);
  pinMode(redLedVehicle, OUTPUT);
  pinMode(greenLedPedestrian, OUTPUT);
  pinMode(redLedPedestrian, OUTPUT);
  pinMode(pushButton, INPUT_PULLUP);
  
  digitalWrite(greenLedVehicle, HIGH);
  digitalWrite(redLedPedestrian, HIGH);
}

  void loop()
{

   if(digitalRead(pushButton) == LOW)
  {
    digitalWrite(greenLedVehicle, LOW);
    digitalWrite(yellowLedVehicle, HIGH);
    delay(2000);
    digitalWrite(yellowLedVehicle, LOW);
    digitalWrite(redLedVehicle, HIGH);
    delay(1000);
    digitalWrite(redLedPedestrian, LOW);
    digitalWrite(greenLedPedestrian, HIGH);
    delay(5000);
    digitalWrite(greenLedPedestrian, LOW);
    digitalWrite(redLedPedestrian, HIGH);
    delay(1000);
    digitalWrite(redLedVehicle, LOW);
    digitalWrite(greenLedVehicle, HIGH);
  }             
}

     
  

ARDUINO CODE



INTRODUCTION
A theremin is an instrument that makes sounds based on the 
movements of a musician’s hands around the instrument. This 
project will use LDR as an input where the amount of light intensity 
will determine the melody notes.

This project applies knowledge outcome from:
Lesson 3: Create Melody with Piezo
Lesson 8: Light Dependent Resistor

INGREDIENTS
a. Maker UNO - 1x
b. Breadboard - 1x
c. Resistor 10kΩ - 1x
d. LDR - 1x
e. Jumper wires

INSTRUCTION
Using all the parts above create an instrument that creates melody played by 
piezo depends on your hand position. The closer your hand is to the LDR, the 
higher the notes produced. When you withdraw your hand, no sound will be 
generated. So, enjoy the melody you create!

Note: To calibrate the sensor, move your hand up and down over the LDR for 5 
seconds to change the amount of light that reaches it. The closer you replicate 
the motions you expect to use while playing the instrument, the better the 
calibration will be.

PROJECT 2
LIGHT THEREMIN 
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SCHEMATIC DIAGRAM

HARDWARE CONNECTION
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  #include "pitches.h"
int melody[49] = {
0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0,
NOTE_C2, NOTE_D2, NOTE_E2, NOTE_F2, NOTE_G2, NOTE_A2, NOTE_B2,
NOTE_C3, NOTE_D3, NOTE_E3, NOTE_F3, NOTE_G3, NOTE_A3, NOTE_B3,
NOTE_C4, NOTE_D4, NOTE_E4, NOTE_F4, NOTE_G4, NOTE_A4, NOTE_B4,
NOTE_C5, NOTE_D5, NOTE_E5, NOTE_F5, NOTE_G5, NOTE_A5, NOTE_B5,
NOTE_C6, NOTE_D6, NOTE_E6, NOTE_F6, NOTE_G6, NOTE_A6, NOTE_B6
};
int sensorValue = 0;
int sensorLow = 1023;
int sensorHigh = 0;
const int ledPin = 13;

  void setup()
{
  pinMode(ledPin, OUTPUT);
  digitalWrite(ledPin, HIGH);
  

  // Calibrate for the first five seconds after program runs

  while(millis() < 5000)
  {
    sensorValue = analogRead(A0);

    if(sensorValue > sensorHigh)
      sensorHigh = sensorValue;

    if(sensorValue < sensorLow)
      sensorLow = sensorValue;
  }
  digitalWrite(ledPin, LOW);
}

  void loop()
{
  sensorValue = analogRead(A0);
  int pitch = map(sensorValue, sensorLow, sensorHigh, 48, 0);
  tone(8, melody[pitch], 50);
  delay(50);
  noTone(8);
  delay(150);
}

     
  

ARDUINO CODE
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